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Based on machine translation technology used by more than three million customers worldwide,
Language Engineering's products offer easy access to Arabic, Chinese, English, French,
German, Hebrew, Italian, Japanese, Korean, Polish, Portuguese, Russian, Spanish and
Ukrainian. The languages you can translate depend upon the package you have purchased.

If you can type, paste, drag or open a file, the world's leading languages are now at your
command! Power Translator gives you instant access to foreign-language information, while
automatically translating your own documents with more accuracy, clarity, and readability than
ever before. It offers powerful, user-friendly features that help you find the right words every
time.

Power Translator uses four user interfaces: 

TextTrans™, Mirror™, QuickTrans™, and FileTrans™. 

Each application is designed to meet different translation needs.

FileTrans™ generates batch translation of files or folders, including HTML. Drag a file or
directory icon into the FileTrans window and the translation is automatic. You can even select
which file types are to be translated, copied, or ignored.

TextTrans™ provides instant translation of text placed into the translation area. You don't even
have to click a button. 

QuickTrans™  creates instant translation as you type. When you work with instant messages,
chats, emails and forms, simply type in your language and have it inserted in another. 

Mirror™ an application that replicates any window1on your desktop in another language in real
time

© Copyright 2002, 2005 Language Engineering Company, LLC and Language Engineering ®
Corporation.

1. Any application that supports standard window's messages will be supported.
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About Language Engineering products

Language Engineering provides individual translation engines for English <> Spanish, German,
French, Italian, Portuguese, Russian, Polish, Ukrainian, Japanese, Chinese, Korean, Arabic,
Hebrew, Persian, Turkish; Spanish <> Italian, French; German <> French, Italian; French <>
Italian. Other language pairs use a two stage translation process with English as an intermediate
between the source and target languages. There are currently 240 language pairs overall. The
language pairs you can translate depends upon the particular package you purchase. 

To increase translation quality in specialised fields, Technical Dictionaries are available for some
languages in Accounting, Aerospace, Agriculture, Architecture, Automotive, Aviation, Banking,
Biology, Biotechnology, Business, Chemical, Chemical Engineering, Civil Engineering,
Computer, Earth Science, Ecology, Economy, Electrical Engineering, Energy, Finance, Geology,
Legal, Marine Technology, Materials Science, Mathematics, Mechanical Engineering, Medical,
Metal Engineering, Microelectronics, Military, Oil/Gas, Patents, Physics, Sociology, Space
Exploration, Telecommunications, Urban Engineering, and Zoology (in Pro Edition only). 

PLUS
•Read the online help for tips and suggestions
•Select the appropriate fonts for each language
•See accents, special characters, and punctuation displayed correctly.

Fast

For instant translation of a document, email, web page or message, you don't even have to 
click a button. Just cut and paste any text for automatic translation.
Easy

If you are using Word, Excel or PowerPoint, a Power Translator menu is added to the menu 
bar. If you are using Internet Explorer, a LEC toolbar appears in the menu bar.

Simply select the language you want for the document you are viewing ,then choose the 
Translate option. If you want to translate large files, websites or multi-document folders, the 
drag-and-drop feature lets you to translate the entire content into the language of your 
choice.
High Quality

The best automatic translation available, Language Engineering Power Translator features 
customised translation engines for each language so you'll get understandable, usable 
translations for an infinite number of sentences.
Flexible

Create personal dictionaries of your own terms and translations. Then access them, along 
with the specialised Language Engineering dictionaries, through a single, consistent 
interface.
4
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System Requirements

Windows® 98, ME, 2000 or XP

Collins Dictionary functions under Windows 2000 and XP only.

Disk space can exceed 1GB depending on the number of language pairs you install. Check the
package for the requirements for your product.

Obtaining Support

Support for our product can be obtained by the following email address:

powertranslator@bmsoftware.com
5
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LEC Translation Bar

The LEC Translation Bar is a control centre for the Language Engineering translation suite. It
provides rapid access to the other available programs, and can be used for translation of small
amounts of text that you type directly into the program. .

To launch the other applications in the translation suite, click on their Quick Launch icon. You
can translate small amounts of text by typing into the text translator pane and then hitting the
Enter key, or choosing "Translate" from the menu. The menu icon lets you configure the
Translation Bar and set options used throughout the translation suite.  

For up-to-date information about all Language Engineering translation products and services,
visit  http://www.lec.com/.

Displays the Power 
Translator 9 menu
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TextTrans™ - Basics

TextTrans is primarily used for quick translation of smaller quantities of text that you type directly
into the program, although it can also be used to translate small text files or text that has been
cut and pasted in. If you wish to translate larger amounts of text, you may want to consider using
FileTrans instead. If you wish to translate HTML documents (web pages), either FileTrans or
Mirror may be used.

Using TextTrans™ 

Typing or dropping Text

Type or paste text into the upper pane of the TextTrans window, this pane (known as the 
source pane) is coloured white. Translation starts as soon as you stop typing/pasting or 
when you choose the Translate command. You can add to or edit the text you have entered; 
TextTrans rapidly detects the change and re-translates the contents of the window 
immediately. You can monitor the progress of your translation and fix any problems with the 
translation from the status bar.

For up-to-date information about all Language Engineering translation products and 
services, visit  http://www.lec.com/.
7
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Files

You can translate text files using TextTrans. This is only suitable for smaller files of 2 to 3 
pages or less. To translate a file choose “Load Source” from the File menu, an “Open 
File” window will appear letting you choose a text file to translate.

At the bottom of the window is a box labelled “Code Page”. This box lets expert users 
override the default code page and specify a different code page that the text file they wish 
to have translated was written in.
Automatic Translation

The description of how to translate under “Typing Text”, “Dropping Text” and “Files” 
assumes that you have automatic translation turned on. When you are using automatic 
translation, TextTrans monitors the source window and starts to translate whenever the 
source text changes. However, there are occasionally times when you may want to control 
when TextTrans begins translating. You can switch to manual translation by choosing 
“Options…” under the Tools menu, navigating to the “Miscellaneous” tab and unticking 
the box marked “Automatically translate source text on the fly”. When you have turned 
off automatic translation, a new item is added to the “Tools” menu named “Translate”. 
TextTrans will translate the source text only when you choose the “Translate” menu item 
(or type Ctrl-T).
8
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Translate Back

The Translate Back feature shows a re-translation of the translated text in the original language.
Translate Back is a tool for judging the readability of your translation. Thus, the text displayed in
the Translate Back window has been translated twice. If the results in the Translate Back window
are understandable, even if the results are far from elegant, you have good reason to think the
first translation is reasonably accurate. You may choose to simplify the wording or sentence
structure of your source text, to see if that improves the readability of the results in the Translate
Back window.

Showing the Translate Back window

To display the Translate Back window, select “Translate Back” from the Tools menu.
Hiding the Translate Back window

You can hide the Translate Back window by clicking on its close box, or by unticking 
“Translate Back” on the Tools menu.
9
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Language Pairs

Translation Languages Pair Chooser

The Translation Languages Button, shown above, lets you see and control which language 
pair you are translating with. It shows a two letters, an arrow, and two more letters. The first 
letters refer to the source language and the second letters to the translation language. 

En->Fr, for example, is shown if you are translating from English to French. If you hover 
over the Translation Languages Button, a full textual description of the language pair is 
shown.

Clicking on the Translation Languages Button displays a menu from where you can choose 
a different translation language. This menu is a simple listing of language pairs if you have 
chosen a subset of the possible language pairs. If you chosen to display all or most of the 
possible language pairs, they will be sorted by source language. You can control the 
contents of this menu as shown in the Options dialog below. 

The Language Pairs panel lets you choose which translation pairs to display in the Translation
Languages button on the Status Bar of the application. You can choose to have all possible
language pairs (well over one hundred) displayed, or prune the list to display only pairs that
contain a particular language, or select the exact list of pairs you wish to have displayed.
10
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Translation Options

If you click on the Language Pairs chooser button, it will drop
down a menu as shown above. From here you can choose
the various language pack that you need to use for
translations.

Clicking on the "Translation Options" menu will open the following window: 

Based on the type of subscription you have, you can choose which dictionaries are used for the
translations. The dictionaries tab is common for all the language pairs.  

The other two tabs (Input, Output) are differ depending upon languages chosen. Based on your
language preferences, you can set the various tabs for the settings you require.
11
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TextTrans - Settings

Clicking on the "Options" button will open the Options window. Selecting the "Miscellaneous" tab
will lets you set options that apply to TextTrans-only. They are as follow:

Automatically translate source text on the fly

Select this option to turn on automatic translation. 
Show Back translation

Select this option to show the Back translation window. 
Show Network Log when error reported

Select this option to automatically show the Network log window whenever a network error 
occurs. 
Show Network Log when warning reported

Select this option to automatically show the Network log window whenever a network 
warning occurs.
12
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QuickTrans™ - Basics

QuickTrans allows you to quickly input text in a language that is familiar to you, but is not your
native language. It is designed to work with any programs that accepts text entry. 

For example, you can use QuickTrans to specify search text in an Internet browser, or to help
you reply to email from another country. 

The QuickTrans window has an area on the right for entering text. Simply type or paste the text
in, press the <Enter>  key to have it translated. You may then edit the result if you wish, and
press <Enter> again to put the translation into your application at the cursor. 

For up-to-date information about all Language Engineering translation products and services,
visit  http://www.lec.com/.

Using QuickTrans™ 

QuickTrans can be controlled and configured by using the series of icons to the left of the text
area. You can have up to five icons visible: the Pushpin, Window Chooser, Network, Translation
Language Pair Chooser, and Menu icons. You can hide any icons you do not need, either from
the menu or from the Miscellaneous Options tab.

Pushpin

When the pushpin is down, QuickTrans stays at a fixed location on the screen. It remains a 
fixed width, although it will grow taller as needed to accommodate any text entered into the 
text area. You can reposition or resize the window as you required. Alternatively, you can 
remove the pushpin and QuickTrans will freely reposition itself on your screen to a location 
that is close to the window to which it will send translated text.

When the pushpin is up, QuickTrans will minimise whenever it is not the front-most window.

This setting is most useful in conjunction with setting a Hot Key, which lets you quickly bring 
up QuickTrans from within any application you are running. If you hide the pushpin, you can 
still change the pushpin setting with the "Window remains at fixed location and width" 
setting on the Miscellaneous Options tab.

Pushpin

Window Chooser

MenuNetwork

Language pairs chooser 
button

Text
13
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Window Chooser

You can use the Window Chooser icon to change the application (called the target 
application) to which QuickTrans sends translation. When QuickTrans is first launched, or is 
brought to the front by a hot key, it tries to target the front-most application. You can change 
the target application by dragging the window chooser icon to a different window. 
QuickTrans will then attempt to target that window. Clicking once on the window chooser 
icon makes QuickTrans target the front-most window.
Send Translation to 'xxx'

You can view this item in the menu by right clicking on the application or clicking on the 
"Menu" link button. This menu item only appears when you have translated text in the text 
area. 'xxx' is replaced with the name of the target application. The Enter key can also be 
used as a faster way of sending the translated text.
Clear Translation

This menu item only appears when you have translated text in the text area. It removes the 
translated text. The escape key can also be used to clear the translated text.

TransView

The TransView window translates text in the opposite direction from the translation languages
set in QuickTrans. For example, when QuickTrans is set to translate from French to English,
TransView translates from English to French.

TransView automatically monitors the text on whichever window QuickTrans is targeting. The
translation occurs automatically. TransView can monitor most applications that accept text entry,
such as Notepad, WordPad and most chat and instant messaging software.
14
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Language Pairs

The Language Pairs button functions in the same way for each application launched by Power
Translator 9.

For more details, see the Language Pairs section p.10.

Translation Options

If you click on the Language Pairs chooser button, it will drop
down a menu as shown above. From here you can choose the
language pack that you need to use for translations.

Clicking on the "Translation Options" menu will open the following window: 

From here, you can choose what dictionaries are used for translations based on your
subscriptions. The dictionaries tab is common for all of the language pairs.
15
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The other two tabs (Input, Output) are different for different languages. Based on your language
preferences you can set the various tabs as you require.

QuickTrans - Settings

Right clicking on the application will show the menu.

Clicking on the "Options" menu will open the Options window. Selecting the "Miscellaneous" will
lets you set options that apply to TextTrans-only. They are as follow:
16
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Window remains at fixed location and width

This sets the pushpin status of the application. For more details, see the explanation of the 
pushpin.
Show TransView Window 

Show or hide the TransView window. This can also be done from the menu.
Animate committing translation

When turned on, a short animation runs showing where the text from QuickTrans is being 
sent. This can be helpful if you find the translated text is not showing up where you expect 
it, which is often due to selecting the incorrect target application.
Pick which icons will be displayed

You can control which icons you want shown in QuickTrans. The window automatically 
grows or shrinks for the number of visible icons. This can also be done from the menu.
Show Network Log when error reported

Select this option to automatically show the Network log window whenever a network error 
occurs.
Show Network Log when warning reported

Select this option to automatically show the Network log window whenever a network 
warning occurs. 
17
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Mirror™ - Basics 

Mirror translates the entire contents of an application's window, automatically responding to
changes made to the text. No commands are needed - the translation happens automatically
and instantly.

For up-to-date information about all Language Engineering translation products and services,
visit http://www.lec.com/.

Using Mirror™ 

Window Chooser

You can use the Window Chooser icon to change what application Mirror translates (called 
the target application). When Mirror is first launched, or is brought to the front by a hot key, 
it tries to target the front-most application. You can change the target application by 
dragging the window chooser icon to a window. Mirror will attempt to target that window. 
Clicking once on the window chooser icon makes Mirror target the front-most window.
Automatic Translation

When green, Mirror continually monitors the text in its target window and re-translates 
whenever that text is changed. If automatic translation is red, it will show the target 
window's contents, but will not translate that contents.
18
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Target

Displays the name of the application window that Mirror is currently targeting.
Progress Indicator

The progress indicator shows you how near completion the current translation is. It is empty 
if no translation is currently running.
Translation Status

The Translation Status indicator will show either “Idle” or “Translating”, depending on 
whether a translation is currently running. It may also show “Error” if a serious problem 
occurs with attempting the translation.

Language Pairs

The Language Pairs button functions in the same way for each application launched by Power
Translator 9.

For more details, see the Language Pairs section p.10.

Translation Options

If you click on the Language Pairs chooser button, it will drop
down a menu as shown above. From here you can choose the
language pack that you need to use for translations.

Clicking on the "Translation Options" menu will open the following window:
19
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From here, you can choose what dictionaries are used for translations based on your
subscriptions. The dictionaries tab is common for all of the language pairs.

The other two tabs (Input, Output) are different for different languages. Based on your language
preferences, you can set the various tabs as you require.
20
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Mirror - Settings

The "Miscellaneous" tab from the "Options" menu, lets you set options that only apply to Mirror.

Window should float above all applications

When selected, Mirror will be the front-most window unless it is minimised or hidden.
Show Menu Bar

When you choose not to show the menu bar, you can still access the menus by right 
clicking within Mirror.
Show Automatic Translation Button on Status Bar

If Automatic Translation is not a feature you use regularly, you can save space by not 
including it on the menu bar. It can still be turned on or off from the menu.
Show Network Log when error reported

Select this option to automatically show the Network log window whenever a network error 
occurs. 
Show Network Log when warning reported

Select this option to automatically show the Network log window whenever a network 
warning occurs.  
Source text automatically comes from the clipboard

When you turn on this feature, Mirror stops its normal application targeting and translates 
the clipboard instead. This can be handy in the rare instances where an application cannot 
normally be targeted by Mirror. To use this method, turn on the feature, go into the 
21
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application containing the text you wish translated, select the required text and choose 
"Copy". The translation will appear in Mirror.

 

22
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FileTrans™- Basics

FileTrans is the fastest and easiest way to translate one or more documents. You can drag and
drop directories or files directly onto the FileTrans window, or use the Translate button to select
the files you wish to have translated. Drag a file onto FileTrans and have the translated file
appear automatically when it finishes.

Alternatively, drag a directory of files onto FileTrans and have all of the files in the directory
translated automatically. You can even drag text directly from your text editor and have it
translated immediately.

FileTrans can read plain text, UNICODE and HTML files. The translated files are created
automatically. 

Text can be translated to any of a dozen languages with a single click of the mouse. You can
monitor the progress of translation, and fix any problems, from the status bar.

For up-to-date information about all Language Engineering translation products and services,
visit www.lec.com.

Using FileTrans™ 

There are several ways to translate files using FileTrans.

1. While FileTrans is running, drag and drop one or more document files or folders onto the 
application window.

2. Copy and paste or drag and drop selected text from another application onto the running 
FileTrans window.
23
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3. While FileTrans is running, click on the "Translate" button or choose "TranslateFile" from 
the menu as shown below.

To display the menu bar click on the "Options" button then the "Miscellaneous" tab and 
select the "Show Menu Bar" option.

4. From the desktop or Windows Explorer, drag one or more files or folders onto the 
FileTrans icon.

The FileTrans window shows the number of files to be translated, the name of the file currently
being translated and a progress indicator in the status bar showing the time remaining to
complete the current translation. 

Click Stop to interrupt the translation process before it is complete. Only fully translated files are
retained.

When FileTrans has finished a translation, it saves the translation in the same folder as the
original file. The translation file has the same name as the original, along with a prefix indicating
which translation was performed. 
24



Power Translator 9 - FileTrans™- Basics

Power Translator 9.book  Page 25  Mercredi, 8. juin 2005  4:31 16
For example, a French translation of an English file named "mysample.txt" is saved as "en to fr
translation of mysample.txt". 

Settings in Options determine whether the newly translated file should be displayed immediately,
plus when the original untranslated file should be retained or deleted.

When FileTrans has finished translating text dropped onto the FileTrans window, it opens a
window (in the default text editor) containing the translated text. If you want to keep the
translation, save it as a file.

For each directory that FileTrans translates, it creates a new directory with the same internal
structure - that is, the files and sub-directories are all in the same place. This new directory is
labelled with a prefix to indicate that it contains translations, but otherwise all of the files have
exactly the same names.

For example, translation of a directory called "MyFiles" from English to French results in a new
directory called "en to fr translation of MyFiles" containing files and sub-directories with the same
names as those inside "MyFiles." Of course, the files in this new directory have been translated
into French.

Settings in Options allow you to choose which types of files are to be translated, and whether
untranslated files are copied unchanged or ignored.

Choosing File Types

This feature lets you control which files should be translated by FileTrans and which should be
ignored. You can select which file types should be excluded from the translation and also

Procedure:

Clicking on "Options" button displays the Options window. Selecting the "Special Files" tab will
show the following window.
25
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From here you can choose which files should be allowed for translation and which are to be
ignored, based on the file extensions.

The tab contains two sections, one to control how FileTrans should handle files that it cannot
translate (such as pictures or data formatted in ways that FileTrans does not understand), and
the other telling FileTrans what files it should treat as web pages and not as ordinary text.

Both sections contain a list of file extensions. To add extensions to the list, type in a new
extension in the text field labelled "Extension" and click the "Add" button. To remove an
extension, select it in the list and click the "Remove" button.

In the top section, which contains the list of file extensions that FileTrans should not try to
translate, there is an additional tickbox that controls whether or not FileTrans should duplicate
files that it cannot translate. If selected, an exact copy of the original file will be placed in the new
translation folder.

Language Pairs

The Language Pairs button functions in thesame way for each application launched by Power
Translator 9.

For more details, see the Language Pairs section p.10.
26
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Translation Options

If you click on the Language Pair chooser button, it will drop
down a menu as shown above. From here you can choose the
various language pack that you need to use for translations.

Clicking on the "Translation Options" menu will open the following window:

From here, you can choose what dictionaries are used for translations based on your
subscriptions. The dictionaries tab is common for all of the language pairs.

The other two tabs (Input, Output) are different for different languages. Based on your language
preferences, you can set the various tabs as you require.
27
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FileTrans - Settings

Clicking on the "Options" button will open the Options window. Selecting the "Miscellaneous" tab
will lets you set options that apply to FileTrans-only. They are as follow:

Open translated file when finished

Select this option to automatically open the translated file, after it has been completely 
translated. This option does not apply when translating folders.
Discard original file when finished

Select this option to delete the original file after it has been completely translated. This 
option does not apply when translating folders.
Show Menu Bar

Select this option to show a menu bar within FileTrans. If deselected, you can still use the 
context or system menu to make menu choices.
Show Network Log when error reported

Select this option to automatically show the Network log window whenever a network error 
occurs. 
Show Network Log when warning reported

Select this option to automatically show the Network log window whenever a network 
warning occurs.
28
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FileTrans - Status Bar

Progress Indicator

The progress indicator shows how near completion the current translation is. It is empty if 
no translation is currently running.
Translation Status

The Translation Status indicator will show either “Idle” or “Translating”, depending on 
whether a translation is currently running. It may also show “Error” if there is a serious 
problem with attempting the translation.
Translation Languages Button/Language Packs Button

The Translation Languages Button, shown above, lets you see and control which language 
pair you are translating with. It shows a two letters, an arrow, and two more letters. The first 
letters refer to the source language and the second letters to the translation language. En-
>Fr, for example, is shown if you are translating from English to French. If you hover over 
the Translation Languages Button, a full textual description of the language pair is shown.

Clicking on the Translation Languages Button displays a menu from where you can choose 
a different translation language. This menu is a simple listing of language pairs if you have 
chosen a subset of the possible language pairs. If you chosen to display all or most of the 
possible language pairs, they will be sorted by source language. You can control the 
contents of this menu from the Language Pair tab of the Options window.
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About Dictionary 

The Dictionary is a small application that lets you look up words in any dictionary. This includes
the default dictionary for a language engine, technical dictionaries and user dictionaries.
Depending upon the package you have purchased, you may also create user dictionaries and
edit entries in them using the Dictionary.

The Dictionary opens from within FileTrans, TextTrans, QuickTrans and Mirror whenever you
choose to browse an open dictionary or look up words. You can also open the Dictionary from
the Windows Start menu, My Computer or Windows Explorer. If you open a dictionary from
Windows Explorer, the Dictionary will be launched automatically.

For up-to-date information about all Language Engineering translation products and services,
visit  www.lec.com.

Dictionary - Basics

Navigation 
Panel

Selection Panel Details Panel

Dictionaries Panel
Entry Properties 
Panel

Status Bar

Menu Bar
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The Navigation panel on the left side of the window shows the entries found in the selected
dictionary or dictionaries, arranged in alphabetical order.

The Menu Bar at the top has five items: File, Edit, Navigation, Tools and Help.

The Selection panel, near the top of the window under the Menu Bar, is used to search for words
in the dictionaries.

The Details panel, at the right of the window just under the Selection panel, lists details of the
selected entry or entries in the Navigation panel.

The Dictionaries panel at the bottom of the screen, just above the Status Bar, gives information
about each loaded dictionary.

The Entry Properties panel at the right of the screen below the Details panel, gives detailed
information about the selected entry.

The Status Bar at the bottom of the LogoMedia Dictionary window gives: information about
network log; the number of matches found; the number of entries currently selected; the number
of dictionaries currently loaded; the search status and the currently selected language pair.

Opening and Closing Dictionaries

The Dictionary can work with more than one dictionary at a time. The list of loaded dictionaries is
shown in the Dictionaries panel at the bottom of the screen.

When looking up a word, choose the dictionaries to be searched from among those loaded, by
selecting one or more from the list box at the far right of the Selection panel. Those selected will
show a tick in the first column of the Dictionaries panel.

 To load a user dictionary or technical dictionary so it can be searched, either:
•Choose Translate Options from the Tools menu
•Click on the language pair at the bottom right and select Translate Options.

To load a dictionary, select the dictionary from "Available section" in the dictionary tab. Then 
click the arrow to transfer it into the "In Use section" and click OK.

You will find all the selected dictionaries are loaded in the Dictionary.
To unload (close) a dictionary so that it can no longer be searched, either: 

•Choose Translate Options from the Tools  menu
•Click on the language pair at the bottom right and then select Translate Options.

To unload a dictionary, select the dictionary from the "In Use section"of the dictionary tab. 
Then click the arrow to transfer it into the "Available section" and click OK.

The selected dictionary will be unloaded from the Dictionary.
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Looking up a Word or Phrase 

1.  Choose the part(s) of the dictionary entries you wish to search: the source text, the
translation text, or both, using the "Source" list.   

For example, suppose you have the language pair set to English to Spanish and are searching
the system dictionary for that pair, with the part of speech set to "Any POS" and "Starts With" set
to "Exact Match."  The search text is 'macho'.

If you ask for "Source" you will see displayed in the Navigation panel the entry 'macho (adj)', with
the Spanish translation 'machote'.

If you ask for "Translation" you will see several entries such as 'bull (n)' and 'male (adj)' with the
Spanish translation 'macho'.

If you ask for "Both" you will see all of these.

Note: Some translation engines do not support searches for "Translation". To see what kinds of
searches, parts of speech, and dictionaries are available for the language pair you have chosen,
look at the choices in the drop-down list boxes for that engine. 

2. Choose the type of search you want from the "Starts With" list in the Selection panel,
just below the Menu Bar.

• To find all entries that match the first letters of a word, choose "Starts With."

For example, a search for 'colo' using "Starts With" would display all of the entries from 'COLO'
Through to 'colossus'. Alternative spelling substitutions are not allowed, so 'colour' would not be
displayed.

Note that using "Starts With" will show entries that have inflected or alternate forms beginning
with the requested characters. For example, if you search for 'we', the Navigation panel will
display entries for 'be', which has the past tense 'were' and 'go', which has the past tense 'went',
among other entries.

•To find all entries that match the last letters of a word, choose "Ends With."

For example, a search for words ending in 'ee' would display all of the entries from', you see'
through 'absentee', 'ad hoc committee', and so forth, down to 'Yankee'.

•To find an entry for a word that may be spelled in more than one way, choose "Rough 
Match."

For example, there may be no entry for 'colour' in the dictionary, but the translation system would
use the definition for 'color' instead. When "Rough Match" is chosen, such substitutions are
allowed.  Thus, looking up 'colour' would display any dictionary entries for 'color'. 

•To find adjectives with prepositions, or verbs with particles and/or prepositions, choose 
"Rough Match" and the relevant POS and type in the bare adjective or verb.

For example, searching for 'sure' with "Rough Match" and "Adjective" chosen will display 'sure'
and 'sure of'. Searching for 'pick' with "Rough Match" and "Verb" will display 'pick on', 'pick out',
and 'pick up on', among others.
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•To find an entry that exactly matches your spelling of a word, choose "Exact Match."

In this case, a search for 'colour' would not match 'color', since no substitutions are allowed with
"Exact Match.".

•To see all the entries in the selected dictionary or dictionaries, choose "All Entries." 

Note: The types of searches supported are engine specific; not all language engines support all
types of searches. "Exact Match" is supported for all engines.

3. Using the Any POS list, choose the part of speech for which to be searched. Examples:
Any POS, Noun, Verb, Adjective, Adverb, Preposition, Conjunction, or Prepositional
Phrase. 

Note: Again, POS is engine specific; different engines support different POS types.

Entries marked  'Special' may be displayed when "Any POS" is chosen. These are entries that
have rarer parts of speech not supported in User Dictionaries. 

4. Using the All Dictionaries list, choose the dictionary or dictionaries to be searched
from among those loaded: All Dictionaries, Technical Dictionaries, User Dictionaries,  or
the System dictionary for the language pair you are using. Select Custom Search to ask
for any combination of dictionaries not listed. 

Those selected will show a tick in the first column of the Dictionaries panel. You can also turn
searching on and off for a given dictionary by clicking in this column.

5. Type the word or phrase you are looking for in the text box in the middle of the
Selection panel. 

When you pause in typing, Language Engineering Dictionaries displays a list of matching words
in the Navigation panel at the left. The first item found (not necessarily the first item in
alphabetical order) is selected, and one or more dictionary entries for that item appear in the
Details panel just below the text box where you entered the word or phrase.

In the Details panel, an entry may include information such as the source word and its inflections
or inflection pattern, part of speech, gender, and dialect; the translation with its translation
pattern, inflections, part of speech, gender, dialect, and semantic features; the dictionary the
item was found in. You can choose which columns appear in this view, and change the width of
the columns by dragging the column separators in the header row. You can also choose on
which column the sort is performed, by double-clicking on the header for that column. 

Note: The information which can be displayed in the Details panel is specific to a particular
language and language engine. 'Gender', for example, is used only by the English to Spanish
engine.  'Inflection pattern' is used only by the other European language engines, and refers to
the inflection class into which a given word falls. For a full explanation, see the User Dictionary
Editor help for those engines. 

The number of matching entries is shown at the right end of the Status Bar, at the bottom of the
window just below the list of loaded dictionaries. 
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6.  If more than one word matches the search, locate and select the item you want in the
Details panel to display the dictionary entry in the Entry Properties pane below it. 
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Text Translation from other programs

From Microsoft Word, Excel or Power Point 

The LEC Office Translation Addin provides easy-to-use translation capabilities to Microsoft
Word, Microsoft Excel and Microsoft PowerPoint. It adds a translation menu to these products,
that lets you select the languages you wish to use in translation and then translate either all or
part of a document. The translation can be done either on your own machine (if you have
purchased this capability) or on a remote machine across the Internet (if you have purchased an
LEC DotNet subscription).

After selecting the language pair you require from the Language Pair menu, translate the
document by choosing "Translate All". The other menu items let you get technical support,
configure how translations should be performed and manage your DotNet subscriptions.

For up-to-date information about all Language Engineering translation products and services,
visit  www.lec.com.  
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From Internet Explorer

The LEC Internet Explorer Translation Bar is an add-in for Internet Explorer that lets you quickly
and easily translate web pages as you browse the Internet. This add-in only works on html files
(web pages); for more general text translation, you should consider using TextTrans. If you have
larger files or wish to batch process multiple files at once, use FileTrans and for email or chat,
QuickTrans will be more suitable. 

After selecting the language pair you wish to use from the Translation Languages button,
translation is completed by clicking once on the Translate Button. Every web page viewed from
that point on will be translated. To switch this off, click the Translate button a second time. For
other options e.g. getting help or setting translation options, click the Menu button. 

For up-to-date information about all Language Engineering translation products and services,
visit www.lec.com. 

Translate Button

Menu Button

Translation 
Languages Button
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Online Translation

Translate DotNet

Authentication

In order to use Language Engineering translations, a user must be authenticated. To do this, the
user must be registered, and have a subscription that covers the required languages.

Registration

Registration is usually completed when the software is installed. If the user has registered on the
Language Engineering website previously, the email and password used then should be used
during installation.

Occasionally an unregistered user might wish to use the Language Engineering products after
they have been installed.  To do this, the user should first make sure that the Network Options
Panel is set to "Request authentication before starting translation". That will bring up the User
Authentication dialog during the first translation.

Users who are already registered enter the appropriate email and password into the boxes
provided. New users should press the "Register" button and register on the Language
Engineering website. When they have finished that registration process, they should use the
password they receive by email and enter it into this window. Users only need to register once -
from then on they merely need to use the correct email and password. If a user forgets their
password, they can go to the Language Engineering website  (http://www.lec.com/Login.asp)
and press the "I've forgotten" button to get the correct password sent to them via email.
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Subscription

Subscriptions allow users to translate between a set of languages. If you purchased a copy of
Language Engineering translation software, you will already be subscribed. If you download an
evaluation copy of the software, you will be given a limited duration subscription to allow you to
"test drive" the software. In either case, you will need to re-subscribe when your subscription has
expired or when you wish to translate between languages not covered by your current
subscription. When this happens, the software will launch the Subscription Dialog, to guide your
choices on which subscriptions to purchase. You can also choose the "Subscribe" menu item to
view all possible subscription choices.

You can set the subscription type and duration, view the details of what the subscription supports
and the cost. If you already have a subscription, you will receive credit for your existing
subscription if you upgrade to a more powerful one. When you have chosen a subscription
option that meets your requirements, press the "Subscribe" button to complete the process. This
will direct your web browser to the Language Engineering website to finish subscribing. If you
wish to view a complete list of your existing subscriptions, press the "View Subscriptions" button
(you can also do this at any time by choosing the "View Subscriptions" menu item.

Typing Text

Type (or paste) the text you wish to be translated into the text translation area. Untranslated text
is coloured black, translated text is coloured blue. To translate the text, press Enter or choose
“Translate” from the menu. You can edit the translation and then drag it or copy it to the clipboard
for use elsewhere. If you wish to enter new text for translation, select all of the translated text
and delete it, or choose “Clear Translation” from the menu, or press the Escape key.
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Miscellaneous

The miscellaneous tab lets you set options that only apply to LogoTransDotNet.
Show Network Log when error reported

Select this option to automatically show the Network log window whenever a network error 
occurs.
Show Network Log when warning reported

Select this option to automatically show the Network log window whenever a network 
warning occurs.

Network

The Network panel lets you set information about the translation server you are using, and your
account information.

Host

The host field specifies the URL of the translation server you are using. Normally, you will not
need to change anything here as the correct value is selected automatically.

If you wish to use a different translation server you can type the URL into the field. If your system
is set up to support more than one server, you can click on the drop-down arrow to get a list of
servers from which to choose.
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When you change translation servers, or if you are experiencing network problems, click on the
“Test Network Connection” button to test your connection to the translation server. After a brief
pause, it will report back the status of your connection to the server.

Authentication

User authentication is needed for all Language Engineering DotNet products. For full details,
see Authentication. 

This set of options is normally set to the correct value at installation. "Server does not require
authentication" is the correct setting for companies who have purchased a licence to run their
own translation server. It should be turned on only by the installer. The other two settings can be
chosen as required by users. "Authenticate for this user" is the most convenient choice; it
automatically logs the user onto the Language Engineering site when the software is first run. If
you want the software to be run by multiple users from the same machine, you can choose
"Request authentication before starting translation". In this case, the first time the software is
asked to do a translation, it brings up the User Authentication dialog and logs in the user.

Language Pairs

The Language Pairs tab lets you choose which translation pairs are displayed by the Translation
Languages Button. You can choose to have all possible language pairs (well over one hundred)
displayed, or prune the list to display pairs that contain a particular language, or select the exact
list of language pairs you need.

Fonts

The Fonts tab lets you choose which font should be used by the software when displaying text in
a particular language. On the left-hand side is a list of languages. Selecting any language shows
the current font settings for that language. You may change the font and font size to any that
support the selected language.

When you select a language, the font and size fields may become blank. In this case, there is no
font on your system that supports the chosen language. The “Install Missing CodePage” button
will then become enabled, letting you update your system to support the selected language.
Different versions of Microsoft’s operating system update the code pages in different ways: it
may be through the control panel or through a web page.

Updates

The Updates tab controls how you will be notified when free updates are available. 

Normally the software checks to see whether updates are available when the program is
launched. Alternatively, select the "Update only when I choose the update menu item" option to
control when the software checks for updates. When an update is found, a window appears
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describing what new features are included. To update the software, simply download and run the
installation file provided. 
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